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Getting Started with Sony Movie Studio By Drew Keller



Sony Vegas Movie Studio is a non-linear video and audio editing system. This application is



designed specifically for Microsoft Windows XP, Vista, and Windows 7. All of the products in the Vegas software family make it relatively easy to import and edit movies, images, and music so you can quickly start your project or movie. This tutorial sequence is focused on the Move Studio family of products. The Vegas Movie Studio HD series gives users the tools to make professional-looking movies without a significant investment in software. Sony also has a professional caliber editorial package titled Sony Vegas Pro, a creative environment for video and broadcast professionals. Vegas Movie Studio 12 HD features real-time multitrack video and audio editing on unlimited tracks, resolution-independent video sequencing, complex effects and compositing tools. For additional information on the Vegas Movie Studio application you can refer to the official Sony Website or other web resources.
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Getting Started From the Start menu on your PC, launch the Sony Vegas Movie Studio Application. You may find the icon in your Toolbar, or you may need to navigate to the Sony Application folder. Launching the software will present a dialog box. You have an option to open an existing project (listed under the Recent Projects section on the left); Create a new project; Start a tutorial; or Start Using the application. You have the option to see this box on startup, or you can hide this The Sony Vegas Studio Welcome Screen. This is the opening dialog dialog by un-checking the option box box when you first launch the application. in the lower left corner. Generally it helpful to show this dialog box as a rapid way to revisit existing projects or create new. A challenge with most video editing software is selecting proper settings so they match the format of your source video. Every camera manufacturer seems to think they have invited a better file format for recoding video files. Additionally, there are many different frame rates and sizes. Picking the right format, size and frame rate can sometimes feel like alchemy because of the myriad of choices. Sony has a clever solution for optimizing video in your project. Selecting “New” in the welcome menu presents a dialog box asking you to choose the format of your project. It is important that this choice reflects the format of your source files. If you know you are working with AVCHD, HDV, or DV footage you can select an option and create your project by clicking “OK”. If you are uncertain of the file format of your source footage click on “Match media settings”. It will guide you through a series of steps where you point the software to a file on your computer representative of your source media. It will optimize your settings to match this media and adjust the frame rate of your project.
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Note: While not critical, if the media settings of your project fail



to match the majority of your source footage your computer will be forced to work much harder. This mismatch can effect performance, real-time playback of effects, render times, and can be the source of unexpected software crashes.



If you expect to leverage multiple types of source files in your project, choose a setting or preset that either a) represents the majority of your footage, or b) the size and frame rate of your final movie. One of the strengths of Sony Vegas is it is excellent at mixing and matching a wide variety of file formats. I often mix HDV, Flip footage and movies from an iPhone in the same project. In that sort of instance I choose settings that mimic the size and frame rate of the file I will output from my session.
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Capturing & Importing Your Files



Before you can begin editing you need to bring video and audio into your computer. This process is called capturing and there are different methods for accomplishing the task, depending on your camera type. If your camera records to a hard drive or memory chip, your camera is file based. See instructions below. If your camera records to video tape (most likely in the DV, DVCam or HDV format) then please refer to the tape based section on page 5.



If Your Video is File Based (Flash Memory or Hard Drive Cameras) 1. Select the Project Media tab 2. Click the Import Media icon (second from left)



3. Navigate to the file directory (a hard drive, memory chip, camera or folder) where you have your media. Media types include video files, still images, music files like MP3, graphic, and animated backgrounds. 4. Select all, or control+click to select your intended media 5. Click “Open” in the dialog box. Media will appear in project media window of the Sony Vegas Movie Studio Application. You are ready to begin editing.
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Capturing From Video Tape Making a connection to the camera or video tape deck 1. Turn on your camera, switch it to playback mode and connect it to your computer. Most cameras will require a firewire connection for transferring the footage, so make certain your PC has a 1394 port or card. For DV and HDV cameras the cable you will use is a firewire cable (IEEE1394 cable). Note: While many cameras have a USB port, this is used to transfer still photos stored on the device. Unfortunately you will be unable to transfer video via the USB cable on tape-based cameras.



2. Once connected to the camera, the computer should recognize the make and model and (if necessary) load the appropriate drivers. Drivers are software patches your computer uses to communicate with an external device. Most often these are found on the manufacturer’s website, so it is important your computer is connected to the internet as it searches for the file. This process may take a few minutes before the two devices “shake hands”. 3. Once you have successfully connected the camera and computer, launch the Vegas application. Start a new project that matches your settings, or open and existing project. 4. Once open, select the Project Media tab 5. Click the capture video icon (third from left)
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6. Select the format (DV or HDV) in the window that appears and select OK.



7. If your camera is connected and turned on (in tape playback mode) a new window may appear asking you to name the tape. Give the tape a unique name, check to see that “Don’t capture any clips right now” is selected and click OK.



A window will open with transport controls, icons and data entry windows.



For capturing your footage Option 1 (the big hammer approach) 1. Shuttle your tape to a point in your tape just before you want to capture (about 10 seconds before.) This could also be the beginning of your tape. 2. Play the tape and press the Capture Video icon to begin capturing. 3. When you have captured the clip, press the Capture Video button again or the stop icon (the square) to stop capture.



StoryGuide.net | © 2012 Drew Keller



6



For capturing your footage Option 2 (the really big hammer approach) 1. Insert your tape into the camera 2. Rewind the tape to the beginning 3. Click on the Capture Tape icon 4. Your entire tape will be captured.



For capturing your footage Option 3 (the finishing hammer approach) 1. Select the Advanced Capture tab at the top of the “Sony Video Capture” window. 2. Cue your footage to about 3 seconds before the beginning of the shot you would like to capture. 3. Select the Mark In icon in the logging window to identify where the shot will begin. (typing “I” (for in point) will accomplish the same task)



4. Play your footage until you are about 3 seconds past the end of your shot. 5. Click the Mark Out icon (next to the Timecode out window) (or type “o” for out) 6. Select Log In/Out to create a log of your clip



7. Type in a short description of the clip in the Clip name window.



8. Repeat process until you have logged all your selected shots from the tape. 9. Once you have completed logging the tape, rewind the tape to the first shot, select all the clips you want to capture and select Batch Capture.
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Logging screen for capturing from a tape-based device in Sony Vegas



Playing Video in the Vegas interface J.K, L & Playing your video One of the most difficult and frustrating parts of learning how to edit is playing your video as you work. When looking for an edit point, searching for a particular part of an interview, or sifting through what seems like endless content, knowing how to stop, start, and navigate around the timeline is critical. The transport controls for playing your video can be accessed in two ways, and you are likely to use both. The most evident method is the transport bar on the software interface. These are the icons that look like the buttons on your video remote. You will see a triangle for play, two lines for pause, and a square for stop. These transport icons appear in a strip at the bottom of the timeline and the video playback window A more efficient way of navigating is using your keyboard. It takes practice, but using the “J”, “K” and “L” keys will significantly increase your speed as an editor. The “J” key plays your video backwards, the “K” pauses your video, and the “L” key plays for video forward. Tapping the “J” or “L” key repeatedly will increase the speed of playback either forwards or backwards. The Spacebar will stop your playback no matter the speed. StoryGuide.net | © 2012 Drew Keller
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Your First Edit – Editing in the timeline How to edit in the timeline You will need at least one media clip in the Project Media Window. We will be moving video from the “Project Media” window down into the area in the bottom half of the screen, referred to as the timeline. This process of editing is a lot like moving paragraphs around in your word processor. We will be selecting a file (represented by the thumbnail in your “project Media” window), dragging it to the timeline and sliding it into place. Editing with Sony Vegas is a very tactile experience, and you will be using your mouse or trackpad extensively.



Making the first edit



1. Select a video clip from the “Project Media” window and drag it to the track marked Video. This is likely to be named track 3 in your timeline.



2. To move a video clip in your timeline click in the center of the clip and drag it left or right.



You can also drag events from one track to another, but for now leave the clip on track 3 You can change the duration of a clip a number of different ways, but most often you will either shorten one end of the clip by dragging the end, or cut off the excess by splitting a clip into two segments and removing the unwanted section. This process is called “trimming”. StoryGuide.net | © 2012 Drew Keller
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Trimming your shot You can adjust the length of your video clip by trimming the beginning and/or end of your file in the timeline. 1. Move your cursor to the beginning of a clip on your timeline and hover over the starting edge of the clip. Your cursor should change from an arrow to the trim tool tip. It looks somewhat like an arrow straddling a box. 2. Click and drag the leading edge of your clip to the right. You are not trying to move the entire clip, but shorten the beginning. You will see the length of your clip grow shorter in the timeline. The duration of your clip is getting shorter.



3. Adjust the end of the clip by hovering over the end of the shot in the timeline and dragging back the end. This process is “non-destructive”. In other words, you can adjust the length of your shot forwards and backwards until you have an edit that works for you.



By dragging events left or right in the timeline, you can make them occur earlier or later in your movie. For example, moving the video to the left will make the clip appear nearer the start of your movie. To the right it moves more to the end.



Note: Don’t be fooled by dragging the end of the clip beyond the start or end thinking you are extending the shot longer than what you captured in the field. Vegas does not have the supernatural power of creating media that does not exist. If you are at the end or beginning of a clip and there is no media available, Vegas will either repeat the shot from the beginning, creating a loop, or freeze the first frame. StoryGuide.net | © 2012 Drew Keller
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Splitting Your Shot in the Timeline One confusing aspect of editing software is the lack of agreement for common terms. This is particularly true with the common function of breaking a video file into two pieces on the timeline. This is a very common function and can be used for breaking a long clip into smaller sections, isolating important phrases from an interview, or trimming the bad parts out of your clip. Avid refers to the process as “Add edit”, Apple's Final Cut Pro calls it “razor” and Sony Vegas calls it “Split”. When you Split an event you divide it into two separate events. This is useful when dividing a video clip into two separate segments or to remove unwanted parts of the video.



1. To split a clip first highlight the clip you would like to adjust by clicking inside it on the timeline. Position your playhead (the long white line in your timeline that shows your position in your video) where you would like to make the edit. The split will happen exactly on the frame where you have stopped your playhead so accuracy is important. You can fine tune the edit point using the left and right arrow keys to move the playhead forward and back one frame at a time.



2. To perform the split you can select Split from the drop down Edit menu, or take the easy route and press the “s” key on your keyboard. Splitting does not affect the original video file; it is merely affecting how the file is played in your sequence. Your source file lives in its entirety on your hard drive. You are merely changing the instructions on how much of it you want included in your final video. StoryGuide.net | © 2012 Drew Keller
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3. Now that the event has been split into two events, you can move them independently, left or right on your timeline. 4. To remove one of the segments you have created highlight the clip you do not want and press the Delete key (or CTL-x). This will remove that section of the clip from the timeline.



Using split and delete is a quick way to trim a shot. A common practice is to drop a clip into your timeline, move the cursor to the point in the shot where you would like it to begin, split the clip, delete the excess and then perform the same task with the end. Once the length is right you can move it into place on your timeline.
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Managing Video Tracks and Layers with Sony Vegas Once you have your base layer of video clips assembled into a sequence of shots you may want to use additional footage above your primary video layer to illustrate a point or create a mood. This action is particularly helpful when you have edited an interview and want to cover part of the person talking with relevant and illustrative images. To accomplish this it is likely you will want your original audio to continue playing while your audience sees the alternative footage. Covering your base layer of video involves creating a new audio track above your first track, adding video to this second layer, moving the audio and video to new tracks, and managing the volume of your new footage’s sound. Let’s get started. 1. First, in the ribbon menu at the top of your screen, make certain you are in “Normal Edit” mode by checking to see if the Normal Edit Tool is selected.



2. If you do not have empty tracks available for adding layers (this would be video and audio tracks with no clips) you will need to add tracks. In the empty space at the bottom of the track header (the area to the left of the timeline) right click and select “Insert Audio Track”.
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3. Right click on the new track and select “Rename”. Enter a one or two word description for this audio track in the text box that appears on the track header. In this instance we can type in the term “Natural Sound”.



4. Move your playhead to the end of your clips in your timeline. This is so you have a clear view of the track where you will be working.



5. Select a clip you would like insert over the top of your existing footage and drag it to the empty space at the end of your timeline.
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6. The audio and video portions of your media are linked together, so you will need to move them to empty tracks in your timeline. First, if it is not already there, move the video event of your new clip to the empty track above your base video track. This is where we will build our cover footage sequence. Next, move the corresponding audio from that clip from the primary audio track (most likely called “voice”) to the new audio track you just created. You can accomplish this by click and dragging the audio file down to the empty track.



7. Using the trim tool (see page 10 for instructions), adjust your clip to the approximate desired duration (just get close; you can fine tune it later.)



One trick for finding your trim point is to play your clip to the position in your shot where you want it to begin (you can fine tune this point using the left and right arrow keys after you have stopped playback). Once you have found your trim point press the “I” key as a marker in your timeline, and then trim the shot back from beginning until you reach the playhead. This process also works for trimming the end of your shot.
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8. Position the playhead at the place in your master sequence where you would like the new shot to begin. Go to the end of the timeline, where you have just placed and trimmed your new shot, click in the center (not the trim tool) and click -drag it back until it lines up with your playhead. You can now use the trim tool to fine tune how your new footage interacts with your base footage.
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Mastering Key Frames with the Envelope Editing Tool While your new shot now looks great, the sound is probably somewhat chaotic as both the old and new tracks are playing simultaneously, competing for the audience’s attention. You need to adjust the volume of the track and this requires using a new tool, The Envelope Editing tool.



1. To get started, click the “Envelope Editing Tool” in the ribbon at the top of the application.



2. Right click on the audio clip you would like to adjust (in this case it is the new clip) and select “Insert/Remove Envelope” --> “Volume”. StoryGuide.net | © 2012 Drew Keller
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3. A purple line will appear in the center of the audio track. This is your volume control, and you will insert anchors (called keyframes) to control when the sound gets louder and when it gets quieter. The position in the center of the track is a neutral position, where the sound playing at 100%, neither dampened nor amplified. We will begin to move it to adjust the sound.



4. Position the cursor at the beginning of the clip until the cursor changes from an arrow to a hand with the index finger extended. Double click at this position and a square will appear on the line. This square is the first keyframe.



Alternately, you can right click on the line at the point where you want to add the keyframe and a contextual menu will appear. Select “Add Point” to drop in a keyframe. A keyframe’s position can be moved (forward and backward in time, or up and down to adjust a parameter) by clicking on a square and sliding it to the desired position.
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5. Insert three more keyframes over the duration of your audio clip. As shown in the example, you should have a total of 4 keyframes.



6. Hover your cursor over the purple line at the center point of your clip and once it turns into a hand, click-drag the line down. This will reduce the volume of your clip. You can also move the individual keyframes to change volume levels over time, or to adjust when the volume change will begin. To put it another way, you move keyframes up and down for volume, and left or right to change the timing.



7. To delete a keyframe right click on the specific keyframe, and a dialog box will appear with options to reset it, delete it or use a preset volume level.
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Creating a Dissolve: Automatic Crossfades



Automatic Crossfades 1. Check in the tool ribbon at the top of the application window to see that Automatic Crossfades has been enabled.



2. Drag an event on the right to overlap an event on the left. A dissolve looks like an “X” on top of the video. You can continue to drag the event to adjust the length of the dissolve, or you can grab the beginning or end of a clip.



3. The overlapping region shows the duration of the dissolve. To preview the event press play. If you double click inside the overlap region on the timeline play will only play the transition
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4. To change the type of transition curve right click on the dissolve curve in your timeline and choose a fade type from the Fade Type menu.







To apply a preset without displaying the Video Event FX dialog, hold the Shift key while dragging a preset from the Transitions window to the timeline.







To move transition controls in fine increments, hold Ctrl while dragging the control.







Select Show event fade lengths from the View menu to display fade lengths between selected and non-selected events in the timeline. You can use this display as a quick indicator of a transition's length.



Creating a Dissolve: Manual Crossfades 1. From the View menu, choose Transitions to display the Transitions window.



2. Select a transition from the list on the left side of the window. The thumbnail images on the right side of the window represent each of the existing presets for the selected transition. Hover your cursor over a preset to see an animated example.
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3. After you've found the setting that you want to use, drag it to the position where you want it to occur on the timeline. You can drop the transition at either end of an event, between two overlapping events, or between two adjacent events.



4. The Video Event FX dialog is displayed to allow you to edit the transitions settings, and an x displayed in the timeline to show you where the transition takes place. You can also click this icon to edit the transition's settings. After you've added a transition to an event, you can easily adjust its duration, which will change the speed at which the transition occurs.



Adjusting Transition Length



1. Hover over the edge of the transition until the cursor is displayed as an



2. Drag the edge of the transition to set its new length:
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Adjusting a transition between two events



Drag either of the events to change the amount of overlap between them. The transition length is updated to match the overlapping area. Right-click a track header and choose Expand Track Layers from the shortcut menu to reveal the A roll, B roll, and transition roll.



In the view to the right, sequential clips alternate between the A and B rolls, and the overlapping area between events is represented by the transition roll.



When you have completed fine tuning your transition, right click the track header and uncheck Expand Track Layers from the shortcut menu.



Deleting a transition



1. Click the



icon on an event to display the Transition dialog.



2. Click the Remove button



to remove the current transition.
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Video Effects, Filters and Looks 1. From the View menu, choose Video FX to toggle the display of the Video FX window.



The left pane lists each of the available video effects, and the thumbnail images in the right pane represent each of the existing presets for the selected effect. Hover your cursor over a preset to see an animated example. You can drag a preset thumbnail to a track, event, or to the Video Preview window to apply the effect. Add video effects to a track, event, media file, or project



To apply a video effect 1. Click the FX button in the location where you want to add video effects.



Each FX button impacts your video differently, depending on which one you have enabled. You can affect a single shot, all the shots on one video layer, all the shots from a particular source media file or the output of the entire movie.



The Video FX dialog is displayed for each of the different FX buttons: StoryGuide.net | © 2012 Drew Keller
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A) Click the Event FX button on a video event to apply an effect to a single event or clip.



B) Click the Track FX button on a track header to apply an effect to a layer. This effect will be applied to every event on th track



C) Click the Media FX button in the Project Media window or hold Alt while clicking the button on an event to apply an effect to every occurrence of a media file in your project (the source media file is not affected).
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D) Click the Video Output FX button in the Video Preview window to apply an effect to every video event in your project.



To add the effects that you have chosen use to the Video FX dialog: 2. From the View menu, choose Video FX to display the Video FX window. Select an effect in the left pane. The thumbnail images in the right pane represent each of the existing presets for the selected effect. Hover your mouse pointer over a preset to see an animated example, and drag the preset you want to use to the Video FX dialog.



—or— There are times when you want to add multiple effects to one shot, track or video. You can add effects together sequentially. This is called a Plug-in Chain. A plug-in Chain is a powerful way to enhance the quality and look of your video. For example, you may want to adjust the color of a shot, add a little glow to the white areas of your image and increase the overall saturation of the color. Using the Plug-in Chain you can connect all of these effects together to create a cohesive look.
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Click the Plug-In Chain button



in the Video FX dialog to display the Plug-In Chooser.



Select each plug-in you want to add and click the Add button. (see below)



Click OK to close the Plug-In Chooser. The order of events in the chain does have an effect on the look of your effect. In color correction it is a common practice to adjust the brightness and contrast first, then the levels, before adjusting the color. It is also common when using blur filters in combination with grain filters (filters that make your video appear like film) to use the blur before using the grain. Otherwise the blur filter will just blur out the grain you are adding, rendering the effect useless. After selecting your plug-ins from the FX dialog box you can change the order of effects.



To reorder the plug-ins within the chain, drag a plug-in earlier or later in the sequence of effect icons. 3. Use the Video FX dialog to enable/bypass effects, edit effect parameters, and add/remove effects from a chain.
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Speed Effects: SloMo, Timewarp and Freeze Frames Adjusting the speed of clips in Vegas is both simple and counterintuitive. It can be difficult to understand at first, but with practice it will make sense. One thing you will discover about speed effects in Vegas is that when you change the speed of a clip it continues to occupy the same amount of time in your timeline. If you are making the clip play faster the software will default to looping the shot over and over. If you are slowing down your shot it will not display the entire shot. After changing the speed you will need to shorten or lengthen the shot in your timeline and move the shots that follow it. Also, this action does not change the speed of the audio, only the video. This is a somewhat inelegant software solution to managing the user experience. One can understand why the Vegas developers made this choice as it keeps the timeline from getting out of sync. But it requires a fair amount of fiddling around with your video to get your expected results.



Creating a Speed Event:



1) Place your clip on your timeline, or identify the clip you want to change. 2) Right click on the clip to reveal the clip menu.
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3) Select the Properties menu item 4) In the dialog box that appears, enter a value in the “Playback rate” text field. Note that 1 is normal speed, 2 is 2x faster, .5 is half speed. Checking the “loop” box will repeat the clip for the duration of the original clip. Deselecting this box will create a freeze if the new duration of the clip (after you have changed the playback rate) is less than the original. For example, if your clip is four seconds in length and you enter a 2 in the “Playback rate” text box the new clip will be 2 seconds long (four seconds played twice as fast will last half as long.) The remaining 2 seconds of the clip will either be a freeze or a repeat of the sped up clip, depending on what you have selected.



5) Once you have selected your speed, close the dialog box and play back the timeline to see if the speed of the clip is as expected. 6) Trim the length of the clip to adjust for the new duration.
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Outputting Your Movie Once you are done with editing your movie in Sony Vegas Movie Studio HD 12 you will need to export your video as a new file. There are a number of names for this process. Vegas uses two terms to accomplish the same task: “Make Movie” and “Render As…” Both will deliver you to your final destination, albeit via different paths. You may want to try each to see what works best for you. Using the “Make Movie” option is completely acceptable and can be the easiest way to finish your video. Sony walks you through the process from beginning to end. Their template eliminates much of the confusion around a process that often looks more like alchemy than science. Using either the “Make Movie” or the “Render As…” function you can export a copy of your final video sequence to a Windows Media, QuickTime, H.264 or AVI movie. I personally prefer to use the “Render As…” function because of the control I have over how my files are created. Sony is unique in using this naming convention for file export (as opposed to the standard “Export” or “Output”), and this can be confusing if you don’t know what to look for. As the “Make Movie” option is fairly self-explanatory within the software, here are some steps for getting started with the “Render As…” exporting process. 1) From your Sony Vegas Studio HD 12 application select Project



--> Render As from the Project drop-down menu.



2) In the Dialog box enter a file name for your completed video 3) In the Output Format Dialog box select your preferred format.



There are multiple individual templates available in Sony Vegas for a diverse list of codecs. If you are unfamiliar with the nuances of creating custom compression templates it is probably best to leverage one of Sony’s preformatted options. StoryGuide.net | © 2012 Drew Keller
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The source of this file in the example above is HD and the size of the video’s canvas (frame) is 720 pixels high, playing at 30 frames per second. Sony provides a description of each template at the bottom of the window to help you choose a compression that will best meet your needs. In this example above we have chosen an MP4 file with a fairly high bitrate. The file created will be larger than what one might find on the web, but the quality of the video will be markedly improved. This is a good choice for something you will be played from a computer, or uploaded to a 3rd-party site (like YouTube or Vimeo) where they will process it with their own compression system.



With the advent of new standards for the internet (HTML5) there are advantages to creating files that leverage the H.264 (MP4) standard. It is a very good format for creating a file that is easily shared on your web site, mobile device or can be uploaded to sharing sites like YouTube or Vimeo



Note: If embedding video into presentation software on a PC (PowerPoint) you should find playback is significantly improved by mastering your final files as Windows Media files (WMV). StoryGuide.net | © 2012 Drew Keller
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If you are creating content to be shared on an intranet (your company, school or organization’s internal network) it is best to check with your IT department to see if they have a preferred format for video on their network. Video files are very big (in comparison to something like a text document) and they can tax internal networks if they are too big, or they may not play if your file format is not supported by your server software. Not all file formats work equally well on all server architectures.



Creating Your Own Templates for Compression and Delivery Occasionally you may need to create custom video templates. This can happen when you need to create a video file that meets a unique situation (higher/lower bitrate, odd-sized canvas or video to meet a specific system requirement).



If you need to create a custom file template:



1. Select the “Customize Template” button in the “Render As” or “Make Movie” dialog box The tabs at the bottom of the Custom Settings window allow you to move from one category to the next as you define your compression options. For example, if I needed to create an HD 720 MP4 (H.264) video that played at 10,000,000 bits-persecond (10 mbps) I would: 2. On the Project tab set Video Rendering quality to Best 3. On the Audio tab a. check the box that says Include audio b. set the sample rate to 48,000 c. Change the Bit rate (bps) menu to 128,000
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4. On the Video Tab section a. make certain the “Include Video” box is checked b. Frame size will default to “(custom frame size)” Using the Width and Height boxes enter the values that match the frame size of your project. If your content is standard definition your frame width should be 640 and your frame height should be 480. If you are using the Flip HD camera your canvas should be 1280 wide by 720 high. If you are using a consumer HD video camera your frame size can be set to 720x1280 or 1080x1920 c. Profile set to “Baseline” d. Frame Rate should be set to 29.97 e. Select the “Constant Bitrate” button and choose 10,000,000 from the drop-down menu. f. Name your template and press the floppy disc icon next to the template text box. I have called it COM597E Output in this example but you can name it whatever you choose. Just make it short and something you will remember. g. Select OK at the bottom of the dialog window.



5. Click Render in the Render As dialog box These instructions represent one starting point for file size, bitrate, canvas size and codec, and there are a multitude of other permutations for creating an optimal video file that will work within a distribution and playback system. As each system is unique, it is advisable that you consult with your IT manager or technician to see if there are existing established standards for your organization.



Note: Clicking on the floppy disk icon in the upper right corner of the Custom Settings window will save your template for future use. If you are going to use this feature be certain you name the template something other than the name the system has populated in the window. This will avoid the risk of inadvertently overwriting a system template.
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About StoryGuide.net: StoryGuide is your source for tips and advice about creating great videos. If you are working in a large organization or you are a student, if you are documenting your family or recording your vacation, StoryGuide will help you produce content that captivates an audience. With nearly 100 free online video tutorials, StoryGuide will help you improve your storytelling, your production skills and make certain your work finds the audience you intend. www,storyguide.net



About the Author: Drew Keller is an award-winning television producer, editor, trainer, developer and educator. His production experience ranges from international documentaries to prime time television specials; community events to national advertising; multimedia to transmedia narratives. He recently completed a special one hour documentary for the PBS Series “BizKid$”. Drew has 15 years’ experience teaching media theory and production. He is currently teaching in the Graduate School in the University of Washington’s MCDM program (Master of Communication in Digital Media). His research and lectures include Web-based storytelling, production best practices, video syndication models and the effects of web video on social networks. Drew presents at nearly 20 conferences and events worldwide each year. He also leads intensive one and two day workshops helping participants improve their skills at storytelling, content creation, camerawork, interviews, editing, channel creation and distribution. Drew’s recent broadcast and online video work includes writing and video editing (Emmy nomination) for “Bizkid$”; project management, production supervision and the development of an internal media portal at a Fortune 500 company; and editing for the PBS documentary series “The Meaning of Food”. Other projects include editing the American Master’s program “Vaudeville”; and editing and production on nearly 30 other long-form national and international projects. Drew is available to work directly with your team, large or small, to customize training and business objectives that will meet your needs. For more information please visit the StoryGuide.biz website, or contact Drew directly at: [email protected] StoryGuide.net | © 2012 Drew Keller
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